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Preface
The PIC18F47Q10 Curiosity Nano evaluation kit is a hardware platform to evaluate microcontrollers in the PIC18-
Q10 Family. This board has the PIC18F47Q10 microcontroller (MCU) mounted.

Supported by MPLAB® X IDE, the board provides easy access to the features of the PIC18F47Q10 to explore how to
integrate the device into a custom design.

The Curiosity Nano series of evaluation boards include an on-board debugger. No external tools are necessary to
program and debug the PIC18F47Q10.

• MPLAB® X IDE - Software to discover, configure, develop, program, and debug Microchip microcontrollers.
• Code examples in MPLAB Discover - Get started with code examples.
• PIC18F47Q10 website - Find documentation, data sheets, sample, and purchase microcontrollers.
• PIC18F47Q10 Curiosity Nano website - Kit information, latest user guide, and design documentation.
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1. Introduction

1.1 Features
• PIC18F47Q10 Microcontroller
• One Yellow User LED
• One Mechanical User Switch
• Footprint for 32.768 kHz Crystal
• On-Board Debugger:

– Board identification in Microchip MPLAB® X IDE
– One green power and status LED
– Programming and debugging
– Virtual serial port (CDC)
– One debug GPIO channel (DGI GPIO)

• USB Powered
• Adjustable Target Voltage:

– MIC5353 LDO regulator controlled by the on-board debugger
– 1.8-5.1V output voltage (limited by USB input voltage)
– 500 mA maximum output current (limited by ambient temperature and output voltage)

1.2 Board Overview
The Microchip PIC18F47Q10 Curiosity Nano evaluation kit is a hardware platform to evaluate the PIC18F47Q10
microcontroller.

Figure 1-1. PIC18F47Q10 Curiosity Nano Board Overview
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2. Getting Started

2.1 Quick Start
Steps to start exploring the PIC18F47Q10 Curiosity Nano board:

1. Download Microchip MPLAB® X IDE.
2. Download MPLAB® XC C Compiler.
3. Launch MPLAB® X IDE.
4. Optional: Use MPLAB® Code Configurator to generate drivers and examples.
5. Write\Develop the application code.
6. Connect a USB cable (Standard-A to Micro-B or Micro-AB) between the PC and the debug USB port on the

board.
7. Program your application onto the device

The PIC18F47Q10 device on the PIC18F47Q10 Curiosity Nano board is programmed and debugged by the
on-board debugger. Therefore, no external programmer or debugger tool is required.

2.1.1 Driver Installation

When the board connects to the computer for the first time, the operating system will perform a driver software
installation. The driver file supports both 32- and 64-bit versions of Microsoft® Windows® XP, Windows Vista®,
Windows® 7, Windows® 8, and Windows® 10. The drivers for the board are included with MPLAB® X IDE.

2.1.2 Kit Window

When the board is connected to a computer and powered on, the green status LED will be lit, the MPLAB® X IDE will
auto-detect which boards are connected. The Kit Window in MPLAB® X IDE will present relevant information like data
sheets and board documentation.

Tip: If closed, reopen the Kit Window in MPLAB® X IDE through the menu bar Window > Kit Window.

2.1.3 MPLAB® X IDE Device Family Packs

Microchip MPLAB® X IDE requires specific information to support devices and tools. This information is contained
in versioned packs. For the PIC18F47Q10 Curiosity Nano board, MPLAB® X version 5.0 with device family
pack “PIC18F-Q_DFP” version 1.0.40 and tool pack “nEDBG_TP” version 1.0.33 or newer is required. For more
information on packs and how to upgrade them, refer to the MPLAB® X IDE User’s guide - Work with Device Packs.

Tip: The latest device family packs are available through Tools > Packs in MPLAB® X IDE or online at
Microchip MPLAB® X Packs Repository.

2.2 Design Documentation and Relevant Links
The following list contains links to the most relevant documents and software for the PIC18F47Q10 Curiosity Nano
board:

• MPLAB® X IDE - MPLAB X IDE is a software program that runs on a PC (Windows®, Mac OS®, Linux®)
to develop applications for Microchip microcontrollers and digital signal controllers. It is named an Integrated
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Development Environment (IDE) because it provides a single integrated “environment” to develop code for
embedded microcontrollers.

• MPLAB® XC Compilers - MPLAB® XC8 C Compiler is available as a free, unrestricted-use download.
Microchips MPLAB® XC8 C Compiler is a comprehensive solution for the project’s software development on
Windows®, macOS® or Linux®. MPLAB® XC8 supports all 8-bit PIC® and AVR® microcontrollers (MCUs).

• MPLAB® Code Configurator - MPLAB Code Configurator (MCC) is a free software plug-in that provides a
graphical interface to configure peripherals and functions specific to your application.

• Microchip Sample Store - Microchip sample store where one can order samples of devices.
• MPLAB Data Visualizer - MPLAB Data Visualizer is a program used for processing and visualizing data. The

Data Visualizer can receive data from various sources, such as serial ports and the on-board debugger’s Data
Gateway Interface, as found on Curiosity Nano and Xplained Pro boards.

• MPLAB Discover - MPLAB Discover is a tool to help you find Microchip example projects and collateral for
Microchip devices.

• PIC18F47Q10 Curiosity Nano website - Kit information, latest user guide, and design documentation.
• PIC18F47Q10 Curiosity Nano on Microchip Direct - Purchase this kit on Microchip Direct.
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3. Curiosity Nano
Curiosity Nano is an evaluation platform of small boards with low pin count microcontroller (MCU) boards with on-
board debuggers and access to most of the microcontrollers I/Os. The Curiosity Nano platform offers easy integration
with MPLAB® X IDE. All boards are identified in the IDE. When connected, a Kit Window appears with links to key
documentation, including relevant user guides, application notes, data sheets, and example code. Everything is easy
to find. The on-board debugger features a virtual serial port (CDC) for serial communication to a host PC and a Data
Gateway Interface (DGI) with debug GPIO pin(s).

3.1 On-Board Debugger Overview
PIC18F47Q10 Curiosity Nano contains an on-board debugger for programming and debugging. The on-board
debugger is a composite USB device consisting of several interfaces:

• A debugger that can program and debug the PIC18F47Q10 in MPLAB® X IDE
• A mass storage device that allows drag-and-drop programming of the PIC18F47Q10
• A virtual serial port (CDC) that is connected to a Universal Asynchronous Receiver/Transmitter (UART) on the

PIC18F47Q10 and provides an easy way to communicate with the target application through terminal software
• A Data Gateway Interface (DGI) for code instrumentation with logic analyzer channels (debug GPIO) to visualize

program flow

The on-board debugger controls a Power and Status LED (marked PS) on the PIC18F47Q10 Curiosity Nano board.
The table below shows how the different operation modes control the LED.

Table 3-1. On-Board Debugger LED Control

Operation Mode Power and Status LED

Boot Loader mode The LED blinks slowly during power-up

Power-up The LED is ON

Normal operation The LED is ON

Programming Activity indicator: The LED blinks slowly during programming/debugging

Drag-and-drop
programming Success: The LED blinks slowly for 2 sec.

Failure: The LED blinks rapidly for 2 sec.

Fault The LED blinks rapidly if a power fault is detected

Sleep/Off The LED is OFF. The on-board debugger is either in a sleep mode or powered down.
This can occur if the board is externally powered.

Info: Slow blinking is approximately 1 Hz, and rapid blinking is about 5 Hz.

3.1.1 Debugger
The on-board debugger on the PIC18F47Q10 Curiosity Nano board appears as a Human Interface Device (HID)
on the host computer’s USB subsystem. The debugger supports full-featured programming and debugging of the
PIC18F47Q10 using MPLAB® X IDE.
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Remember: Keep the debugger’s firmware up-to-date. Firmware upgrades automatically when using
MPLAB® X IDE.

3.1.2 Virtual Serial Port (CDC)
The virtual serial port (CDC) is a general purpose serial bridge between a host PC and a target device.

3.1.2.1 Overview
The on-board debugger implements a composite USB device with a standard Communications Device Class (CDC)
interface, which appears on the host as a virtual serial port. Use the CDC to stream arbitrary data between the host
computer and the target in both directions: All characters sent through the virtual serial port on the host computer will
be transmitted as UART on the debugger’s CDC TX pin. The UART characters captured on the debugger’s CDC RX
pin will be returned to the host computer through the virtual serial port.

Figure 3-1. CDC Connection
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Info: The debugger’s CDC TX pin is connected to a UART RX pin on the target for receiving characters
from the host computer, as shown in the figure above. Similarly, the debugger’s CDC RX pin is connected
to a UART TX pin on the target for transmitting characters to the host computer.

3.1.2.2 Operating System Support
On Windows® machines, the CDC will enumerate as Curiosity Virtual COM Port and appear in the Ports section of
the Windows Device Manager. The COM port number can also be found there.

Info: On older Windows systems, the CDC requires a USB driver. The MPLAB® X IDE installation
Includes this driver.

On Linux® machines, the CDC will enumerate and appear as /dev/ttyACM#.

Info: tty* devices belong to the “dialout” group in Linux, so it may be necessary to become a member of
that group to have permission to access the CDC.

On Mac® machines, the CDC will enumerate and appear as /dev/tty.usbmodem#. Depending on the terminal
program used, it will appear in the available list of modems as usbmodem#.
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Info: For all operating systems, use a terminal emulator that supports DTR signaling. See
3.1.2.4.  Signaling.

3.1.2.3 Limitations
Not all UART features are implemented in the on-board debugger CDC. The constraints are outlined here:

• Baud rate: Must be in the range of 1200 bps to 500 kbps. Any baud rate outside this range will be set to the
closest limit without warning. Baud rate can be changed on-the-fly.

• Character format: Only 8-bit characters are supported.
• Parity: Can be odd, even, or none.
• Hardware flow control: Not supported.
• Stop bits: One or two bits are supported.

3.1.2.4 Signaling
During USB enumeration, the host OS will start both the communication and data pipes of the CDC interface. At this
point, it is possible to set and read back the baud rate and other UART parameters of the CDC, but data sending and
receiving will not be enabled.

The terminal must assert the DTR signal when it connects to the host. As this is a virtual control signal implemented
on the USB interface, it is not physically present on the board. Asserting the DTR signal from the host will indicate to
the on-board debugger that a CDC session is active. The debugger will enable its level shifters (if available) and start
the CDC data send and receive mechanisms.

Deasserting DTR in debugger firmware version 1.20 or earlier has the following behavior:
• Debugger UART receiver is disabled, and no further data will be transferred to the host computer
• Debugger UART transmitter will continue to send queued data ready for transfer, but no new data is accepted

from the host computer
• Level shifters (if available) are not disabled, and the debugger CDC TX line remains driven

Deasserting DTR in debugger firmware version 1.21 or later has the following behavior:
• Debugger UART receiver is disabled, and no further data will be transferred to the host computer
• Debugger UART transmitter will continue to send queued data ready for transfer, but no new data is accepted

from the host computer
• Once the ongoing transmission is complete, level shifters (if available) are disabled, and the debugger CDC TX

line will become high-impedance

Remember: Set up the terminal emulator to assert the DTR signal. Without the signal, the on-board
debugger will not send or receive data through its UART.

Tip: The on-board debugger’s CDC TX pin will not be driven until the CDC interface is enabled by the
host computer. Also, there are no external pull-up resistors on the CDC lines connecting the debugger
and the target, which means that the lines are floating during power-up.The target device may enable the
internal pull-up resistor on the pin connected to the debugger’s CDC TX pin to avoid glitches resulting in
unpredictable behavior like framing errors.

 PIC18F47Q10 Curiosity Nano
Curiosity Nano

© 2022 Microchip Technology Inc.
and its subsidiaries

 User Guide DS40002103C-page 8



3.1.2.5 Advanced Use

CDC Override Mode
In ordinary operation, the on-board debugger is a true UART bridge between the host and the device. However, in
certain use cases, the on-board debugger can override the basic Operating mode and use the CDC TX and RX pins
for other purposes.

Dropping a text file into the on-board debugger’s mass storage drive can be used to send characters out of the
debugger’s CDC TX pin. The filename and extension are trivial, but the text file will start with the characters:

CMD:SEND_UART=

Debugger firmware version 1.20 or earlier has the following limitations:
• The maximum message length is 50 characters – all remaining data in the frame are ignored
• The default baud rate used in this mode is 9600 bps, but if the CDC is already active or configured, the

previously used baud rate still applies

Debugger firmware version 1.21 and later has the following limitations/features:
• The maximum message length will vary depending on the MSC/SCSI layer timeouts on the host computer

and/or operating system. A single SCSI frame of 512 bytes (498 characters of payload) is ensured, and files up
to 4 KB will work on most systems. The transfer will complete on the first NULL character encountered in the file.

• The baud rate used is always 9600 bps for the default command:

CMD:SEND_UART=

• Do not use the CDC Override mode simultaneously with data transfer over the CDC/terminal. If a CDC terminal
session is active when receiving a file via the CDC Override mode, it will be suspended for the duration of the
operation and resumed once complete.

• Additional commands are supported with explicit baud rates:

CMD:SEND_9600=

CMD:SEND_115200=

CMD:SEND_460800=

USB-Level Framing Considerations
Sending data from the host to the CDC can be done byte-wise or in blocks, chunked into 64-byte USB frames. Each
such frame will be queued for transfer to the debugger’s CDC TX pin. Sending a small amount of data per frame can
be inefficient, particularly at low baud rates, as the on-board debugger buffers frames but not bytes. A maximum of
four 64-byte frames can be active at any time. The on-board debugger will throttle the incoming frames accordingly.
Sending full 64-byte frames containing data is the most efficient method.

When receiving data on the debugger’s CDC RX pin, the on-board debugger will queue up the incoming bytes into
64-byte frames, which are sent to the USB queue for transmission to the host when they are full. Incomplete frames
are also pushed to the USB queue at approximately 100 ms intervals, triggered by USB start-of-frame tokens. Up to
eight 64-byte frames can be active at any time.

An overrun will occur if the host (or the software running on it) fails to receive data fast enough. When this happens,
the last-filled buffer frame recycles instead of being sent to the USB queue, and a complete data frame will be lost. To
prevent this occurrence, the user will ensure that the CDC data pipe is continuously read, or the incoming data rate
will be reduced.

Sending Break Characters
The host can send a UART break character to the device using the CDC. This can be useful for resetting a receiver
state-machine or signalling an exception condition from the host to the application running on the device.

A break character is defined as a sequence of at least 11 zero bits transmitted from the host to the device.

 PIC18F47Q10 Curiosity Nano
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Not all UART receivers have support for detecting a break, but a correctly-formed break character usually triggers a
framing error on the receiver.

Sending a break character using the debugger's CDC has the following limitations:
• Sending a break must NOT be done at the same time as using the CDC Override mode (drag-and-drop). Both

these functions are temporary states, so they must be used independently.
• Sending a break will cause data currently being sent to be lost. Be sure to wait a sufficient amount of time to

allow all characters in the transmission buffer to be sent (see above section) before sending the break. This is
also in line with expected break character usage: For example, reset a receiver state-machine after a timeout
occurs waiting for data to be returned to the host.

• The CDC specification allows for debugger-timed breaks of up to 65534ms in duration to be requested. For
simplicity, the debugger will limit the break duration to a maximum of 11 bit-durations at its minimum supported
baud rate.

• The CDC specification allows for indefinite host-timed breaks. It is the responsibility of the terminal application/
user to release the break state in this case.

Note:  Sending break characters is available in debugger firmware version 1.24 and later.

3.1.3 Mass Storage Device
The on-board debugger includes a simple Mass Storage Device implementation, which is accessible for read/write
operations via the host operating system to which it is connected.

It provides:
• Read access to basic text and HTML files for detailed kit information and support
• Write access for programming Intel® HEX formatted files into the target device’s memory
• Write access for simple text files for utility purposes

3.1.3.1 Mass Storage Device Implementation
The on-board debugger implements a highly optimized variant of the FAT12 file system having several limitations,
partly due to the nature of FAT12 itself and optimizations made to fulfill its purpose for its embedded application.

The Curiosity Nano USB device is USB Chapter 9-compliant as a mass storage device but does not, in any way, fulfill
the expectations of a general purpose mass storage device. This behavior is intentional.

When using the Windows operating system, the on-board debugger enumerates as a Curiosity Nano USB Device
found in the disk drives section of the device manager. The CURIOSITY drive appears in the file manager and claims
the following available drive letter in the system.

The CURIOSITY drive contains approximately one MB of free space and does not reflect the target device’s Flash
size. When programming an Intel® HEX file, the binary data are encoded in ASCII with metadata providing a large
overhead, so 1 MB is a trivially chosen value for disk size.

It is not possible to format the CURIOSITY drive. The filename may appear in the disk directory listing when
programming a file to the target, which is merely the operating system’s view of the directory that, in reality, has not
been updated. It is not possible to read out the file contents. Removing and replugging the board will return the file
system to its original state, but the target will still contain the previously programmed application.

Copy a text file starting with “CMD:ERASE” onto the disk to erase the target device.

By default, the CURIOSITY drive contains several read-only files for generating icons as well as reporting status and
linking to further information:

• AUTORUN.ICO – icon file for the Microchip logo
• AUTORUN.INF – system file required for Windows Explorer to show the icon file
• KIT-INFO.HTM – redirect to the development board website
• KIT-INFO.TXT – a text file containing details about the board’s debugger firmware version, board name, USB

serial number, device, and drag-and-drop support
• STATUS.TXT – a text file containing the programming status of the board
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Info: STATUS.TXT is dynamically updated by the on-board debugger. The contents may be cached by the
OS and, therefore, not reflecting the correct status.

3.1.3.2 Configuration Words

Configuration Words (PIC® MCU Targets)
Configuration Word settings included in the project being programmed after program Flash is programmed. The
debugger will not mask out any bits in the Configuration Words when writing them, but since it uses Low-Voltage
Programming mode, it can't clear the LVP Configuration bit. If the incorrect clock source is selected, for example, and
the board does not boot, it is always possible to perform a bulk erase (always done before programming) and restore
the device to its default settings.

3.1.3.3 Special Commands
Several utility commands are supported by copying text files to the mass storage disk. The filename or extension is
irrelevant – the command handler reacts to content only.

Table 3-2. Special File Commands

Command Content Description

CMD:ERASE Executes a chip erase of the target

CMD:SEND_UART= Sends a string of characters to the CDC UART. See “CDC
Override Mode.”

CMD:SEND_9600=
CMD:SEND_115200=
CMD:SEND_460800=

Sends a string of characters to the CDC UART at the specified
baud rate. Note that only the baud rates explicitly specified here
are supported! See “CDC Override Mode”. (Debugger firmware
v1.21 or newer.)

CMD:RESET Resets the target device by entering Programming mode and
exiting Programming mode immediately afterward. The exact
timing can vary according to the programming interface of the
target device. (Debugger firmware v1.16 or newer.)

CMD:POWERTOGGLE Powers down the target and restores it after a 100 ms delay.
If external power is provided, this has no effect. (Debugger
firmware v1.16 or newer.)

CMD:0V Powers down the target device by disabling the target supply
regulator. If external power is provided, this has no effect.
(Debugger firmware v1.16 or newer.)

CMD:1V8 Sets the target voltage to 1.8V. If external power is provided,
this has no effect. (Debugger firmware v1.21 or newer.)

CMD:3V3 Sets the target voltage to 3.3V. If external power is provided,
this has no effect. (Debugger firmware v1.16 or newer.)

CMD:5V0 Sets the target voltage to 5.0V. If external power is provided,
this has no effect. (Debugger firmware v1.16 or newer.)

Info: The content sent to the mass storage emulated disk triggers the commands listed here and provides
no feedback in the case of either success or failure.
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3.1.4 Data Gateway Interface (DGI)
Data Gateway Interface (DGI) is a USB interface for transporting raw and timestamped data between on-board
debuggers and host computer-based visualization tools. MPLAB Data Visualizer is used on the host computer to
display any debug GPIO data. It is available as a plug-in for MPLAB® X IDE or a stand-alone application that can be
used in parallel with MPLAB® X IDE.

Although DGI encompasses several physical data interfaces, the PIC18F47Q10 Curiosity Nano implementation
includes logic analyzer channels:

• One debug GPIO channel (also known as DGI GPIO)

3.1.4.1 Debug GPIO
Debug GPIO channels are timestamped digital signal lines connecting the target application to a host computer
visualization application. They are typically used to plot low-frequency events on a time axis – for example, when
given Application state transitions occur.

The figure below shows the monitoring of the Digital state of a mechanical switch connected to a debug GPIO in
MPLAB Data Visualizer.
Figure 3-2. Monitoring Debug GPIO with MPLAB® Data Visualizer

Debug GPIO channels are timestamped, so the resolution of DGI GPIO events is determined by the resolution of the
DGI Timestamp module.

Important:  Although signal bursts of higher frequency can be captured, the frequency range of signals
for which debug GPIO can be used is up to about 2 kHz. Attempting to capture signals above this
frequency will result in data saturation and overflow, which may cause the DGI session to be aborted.

3.1.4.2 Timestamping
DGI sources are timestamped when they are captured by the debugger. The timestamp counter implemented in the
Curiosity Nano debugger increments at a 2 MHz frequency, providing a timestamp resolution of a half microsecond.

3.2 Curiosity Nano Standard Pinout
The 12 edge connections closest to the USB connector on Curiosity Nano boards have a standardized pinout. The
program/debug pins have different functions depending on the target programming interface, as shown in the table
and figure below.
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Table 3-3. Curiosity Nano Standard Pinout

Debugger Signal Target MCU Description

ID — ID line for extensions

CDC TX UART RX USB CDC TX line

CDC RX UART TX USB CDC RX line

DBG0 ICSPDAT Debug data line

DBG1 ICSPCLK Debug clock line

DBG2 GPIO0 debug GPIO0

DBG3 MCLR Reset line

NC — No connect

VBUS — VBUS voltage for external use

VOFF — Voltage Off input. Disables the target regulator and
target voltage when pulled low.

VTG — Target voltage

GND — Common ground

Figure 3-3. Curiosity Nano Standard Pinout
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3.3 Power Supply
The USB port powers the board. It contains two LDO regulators, one to generate 3.3V for the on-board debugger and
an adjustable LDO regulator for the target PIC18F47Q10 microcontroller and its peripherals. The voltage from a USB
connector can vary between 4.4V and 5.25V (according to the USB specification) and will limit the maximum voltage
supplied to the target. The figure below shows the entire power supply system on PIC18F47Q10 Curiosity Nano.
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Figure 3-4. Power Supply Block Diagram
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3.3.1 Target Regulator
The target voltage regulator is a MIC5353 variable output LDO. The on-board debugger can adjust the voltage output
supplied to the board target section by manipulating the MIC5353’s feedback voltage. The hardware implementation
is limited to an approximate voltage range from 1.7V to 5.1V. Additional output voltage limits are configured in
the debugger firmware to ensure that the output voltage never exceeds the hardware limits of the PIC18F47Q10
microcontroller. The voltage limits configured in the on-board debugger on PIC18F47Q10 Curiosity Nano are 1.8–
5.5V.

Info: The factory default target voltage is 3.3V. It can be changed through the MPLAB® X IDE project
properties. Any change to the target voltage is persistent, even after a power toggle. The resolution is less
than 5 mV but may be limited to 10 mV by the adjustment program.

Info: The voltage settings setup in MPLAB® X IDE is not applied immediately to the board. The new
voltage setting is applied to the board when accessing the debugger, like pushing the Refresh Debug Tool
Status button in the project dashboard tab or programming/reading program memory.

Info: There is an easy option to adjust the target voltage with a drag-and-drop command text file to the
board, which supports a set of common target voltages. See section 3.1.3.3.  Special Commands for
further details.

MIC5353 supports a maximum current load of 500 mA. It is an LDO regulator in a small package, placed on a
small printed circuit board (PCB), and the thermal shutdown condition can be reached at lower loads than 500 mA.
The maximum current load depends on the input voltage, the selected output voltage, and the ambient temperature.
The figure below shows the safe operating area for the regulator, with an input voltage of 5.1V and an ambient
temperature of 23°C.
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Figure 3-5. Target Regulator Safe Operation Area

The voltage output of the target regulator is continuously monitored (measured) by the on-board debugger. If it is
more than 100 mV over/under the set device voltage, an error condition will be flagged, and the target voltage
regulator will be switched off, detecting and handling any short-circuit conditions. It will also detect and handle if an
external voltage, which causes VCC_TARGET to move outside the voltage setting monitoring window of ±100 mV, is
suddenly applied to the VTG pin without setting the VOFF pin low.

Info: The on-board debugger has a monitoring window of VCC_TARGET±100 mV. The on-board debugger
status LED will blink rapidly if the external voltage is under this limit. The on-board debugger status LED
will continue to shine if the external voltage is above this limit. When removing the external voltage, the
status LED will start blinking rapidly until the on-board debugger detects the new situation and turns the
target voltage regulator back on.

3.3.2 External Supply
Instead of the on-board target regulator, an external voltage can power the PIC18F47Q10 Curiosity Nano. When
shorting the Voltage Off (VOFF) pin to the ground (GND) pin, the on-board debugger firmware disables the target
regulator, and it is safe to apply an external voltage to the VTG pin.

It is also safe to apply an external voltage to the VTG pin when no USB cable is plugged into the DEBUG connector
on the board.

The VOFF pin can be tied low/let go at any time, which will be detected by a pin-change interrupt to the on-board
debugger, which controls the target voltage regulator accordingly.

WARNING
Applying an external voltage to the VTG pin without shorting VOFF to GND may cause permanent damage
to the board.

WARNING
Do not apply any voltage to the VOFF pin. Let the pin float to enable the power supply.

WARNING
The absolute maximum external voltage is 5.5V for the on-board level shifters, and the standard operating
condition of the PIC18F47Q10 is 1.8–5.5V. Applying a higher voltage may cause permanent damage to
the board.
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Info: If an external voltage is applied without pulling the VOFF pin low and an external supply pulls the
voltage lower than the monitoring window’s lower limit (target voltage setting – 100 mV), the on-board
debugger status LED will blink rapidly and shut the on-board regulator off. If an external voltage is
suddenly removed when the VOFF pin is not pulled low, the status LED will start to blink rapidly until the
on-board debugger detects the new situation and switches the target voltage regulator back on.

Programming, debugging, and data streaming are still possible with an external power supply. The USB cable will
power the debugger and signal level shifters. Both regulators, the debugger, and the level shifters are powered down
when the USB cable is removed.

Info: In addition to the power consumed by the PIC18F47Q10 and its peripherals, approximately 100 µA
will be drawn from any external power source to power the on-board level shifters and voltage monitor
circuitry when a USB cable is plugged into the DEBUG connector on the board. When a USB cable is not
plugged in, some current is used to supply the level shifter’s voltage pins, which have a worst-case current
consumption of approximately 5 µA. Typical values may be as low as 100 nA.

3.3.3 VBUS Output Pin
PIC18F47Q10 Curiosity Nano has a VBUS output pin that can be used to power external components that need a 5V
supply. The VBUS output pin has a PTC fuse to protect the USB against short circuits. A side effect of the PTC fuse
is a voltage drop on the VBUS output with higher current loads. The chart below shows the voltage versus the current
load of the VBUS output.

Figure 3-6. VBUS Output Voltage vs. Current

3.3.4 Power Supply Exceptions
This chapter sums up most exceptions that can occur with the power supply.
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Target Voltage Shuts Down
Not reaching the target voltage setting can happen if the target section draws too much current at a given voltage and
cause the thermal shutdown safety feature of the MIC5353 regulator to kick in. To avoid this, reduce the current load
of the target section.

Target Voltage Setting is Not Reached
The USB input voltage (4.4-5.25V) limits the maximum output voltage, the voltage drop over the MIC5353 regulator
at a given voltage setting, and current consumption. If a higher output voltage is needed, use a USB power source
that can provide a higher input voltage or use an external voltage supply on the VTG pin.

Target Voltage is Different From Setting
An externally applied voltage to the VTG pin without setting the VOFF pin low can cause this. If the target voltage
differs more than 100 mV over/under the voltage setting, the on-board debugger will detect it, and the internal voltage
regulator will shut down. To fix this issue, remove the applied voltage from the VTG pin, and the on-board debugger
will enable the on-board voltage regulator when the new condition is detected. Note that the PS LED will blink rapidly
if the target voltage is below 100 mV of the setting but will ordinarily turn on when higher than 100 mV above the
setting.

No, Or Very Low Target Voltage, and PS LED is Blinking Rapidly
A full or partial short circuit can cause this and is a particular case of the issue mentioned above. Remove it, and the
on-board debugger will re-enable the on-board target voltage regulator.

No Target Voltage and PS LED is Lit 1
This occurs if the target voltage is set to 0.0V. To fix this, set the target voltage to a value within the specified voltage
range for the target device.

No Target Voltage and PS LED is Lit 2
This can be the issue if power jumper J100 and/or J101 is cut, and the target voltage regulator is set to a value within
the specified voltage range for the target device. To fix this, solder a wire/bridge between the pads for J100/J101, or
add a jumper on J101 if a pin-header is mounted.

VBUS Output Voltage is Low or Not Present
If the VBUS output voltage is low or missing, the reason is probably a high-current drain on VBUS, and the protection
fuse (PTC) will reduce the current or cut off completely. Reduce the current consumption on the VBUS pin to fix this
issue.

3.4 Low-Power Measurement
Power to the PIC18F47Q10 is connected from the on-board power supply and VTG pin through a 100 mil pin-header
marked with “POWER” in silkscreen (J101). To measure the power consumption of the PIC18F47Q10 and other
peripherals connected to the board, cut the Target Power strap and connect an ammeter over the strap.

To measure the lowest possible power consumption, follow these steps:
1. Cut the POWER strap with a sharp tool.
2. Solder a 1x2 100 mil pin-header in the footprint.
3. Connect an ammeter to the pin header.
4. Write firmware that:

a. Tri-states any I/O connected to the on-board debugger.
b. Sets the microcontroller in its lowest Power sleep mode.

5. Program the firmware into the PIC18F47Q10.
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Figure 3-7. Target Power Strap

Target Power strap (top side)

Tip: A 100-mil pin-header can be soldered into the Target Power strap (J101) footprint for a simple
connection of an ammeter. Place a jumper cap on the pin-header once the ammeter is no longer needed.

Info: The on-board level shifters will draw a small amount of current even when not used. Maximum
2 µA can be drawn from each I/O pin connected to a level shifter, the worst case maximum for the 5
on-board level shifters is therefore 10 µA. Keep any I/O pin connected to a level shifter in tri-state to
prevent leakage. All I/Os connected to the on-board debugger are listed in 4.2.4.1.  On-Board Debugger
Connections. The on-board level shifters can be completely disconnected to prevent leakage, as described
in 7.4.  Disconnecting the On-Board Debugger.

3.5 Programming External Microcontrollers
The on-board debugger on PIC18F47Q10 Curiosity Nano can be used to program and debug microcontrollers on
external hardware.

3.5.1 Supported Devices
All external AVR microcontrollers with the UPDI interface can be programmed and debugged with the on-board
debugger with Microchip Studio.

External SAM microcontrollers having a Curiosity Nano Board can be programmed and debugged with the on-board
debugger with Microchip Studio.

PIC18F47Q10 Curiosity Nano can program and debug external PIC18F47Q10 microcontrollers with MPLAB X IDE.

3.5.2 Software Configuration
No software configuration is required to program and debug the same device mounted on the board.
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To program and debug a different microcontroller than the one mounted on the board, configure Microchip Studio to
allow an independent selection of devices and programming interfaces.

1. Navigate to Tools > Options through the menu system at the top of the application.
2. Select the Tools > Tool settings category in the options window.
3. Set the Hide unsupported devices option to False.

Figure 3-8. Hide Unsupported Devices

Info:  Microchip Studio allows any microcontroller and interface to be selected when the Hide
unsupported devices setting is set to False - also microcontrollers and interfaces not supported by
the on-board debugger.

3.5.3 Hardware Modifications
The on-board debugger is connected to the PIC18F47Q10 by default. Remove these connections before any external
microcontroller can be programmed or debugged. Cut the GPIO straps shown in the figure below with a sharp tool to
disconnect the PIC18F47Q10 from the on-board debugger.
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Figure 3-9. Programming and Debugging Connections to Debugger

GPIO straps (bottom side)

Info: Cutting the connections to the debugger will disable programming, debugging, and data streaming
from the PIC18F47Q10 mounted on the board.

Tip: Solder 0Ω resistors across the footprints or short circuit them with solder to reconnect the signals
between the on-board debugger and the PIC18F47Q10.

3.5.4 Connecting to External Microcontrollers
The figure and table below show where to connect the programming and debugging signals to program and debug
external microcontrollers. The on-board debugger can supply power to the external hardware or use an external
voltage as a reference for its level shifters. Read more about the power supply in 3.3.  Power Supply.

The on-board debugger and level shifters actively drive data and clock signals used for programming and debugging
(DBG0, DBG1, and DBG2). Pull-down resistors are required on the ICSP™ data and clock signals to debug PIC®

microcontrollers. All other interfaces are functional with or without pull-up or pull-down resistors.

DBG3 is an open-drain connection and requires a pull-up resistor to function.

PIC18F47Q10 Curiosity Nano has pull-down resistors R204 and R205 connected to the ICSP data and clock signal
(DBG0 and DBG1). There is also a pull-up resistor R200 connected to the MCLR signal (DBG3). The location of pull
resistors is shown in 7.2.  Assembly Drawing in the appendix.

Remember: 
• Connect GND and VTG to the external microcontroller
• Tie the VOFF pin to GND if the external hardware has a power supply
• Make sure there are pull-down resistors on the ICSP data and clock signals (DBG0 and DBG1) to

support the debugging of PIC microcontrollers
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Figure 3-10. Curiosity Nano Standard Pinout
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Table 3-4. Programming and Debugging Interfaces

Curiosity Nano Pin UPDI ICSP™ SWD

DBG0 UPDI DATA SWDIO

DBG1 — CLK SWCLK

DBG2 — — —

DBG3 — MCLR RESET

3.6 Connecting External Debuggers
Even though there is an on-board debugger, external debuggers can be connected directly to the PIC18F47Q10
Curiosity Nano to program/debug the PIC18F47Q10. When not actively used, the on-board debugger keeps all the
pins connected to the PIC18F47Q10 and board edge in tri-state. Therefore, the on-board debugger will not interfere
with any external debug tools.
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Figure 3-11. Connecting the MPLAB® PICkit™ 4 In-Circuit Debugger/Programmer to PIC18F47Q10 Curiosity
Nano
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CAUTION
The MPLAB® PICkit™ 4 In-circuit Debugger/Programmer can deliver high voltage on the MCLR pin. High
voltage can permanently damage R110. If R110 is broken, the on-board debugger cannot enter the
programming mode of the PIC18F47Q10 and will typically fail at reading the device ID.

CAUTION
To avoid contention between the external debugger and the on-board debugger, do not start any
programming/debug operation with the on-board debugger through MPLAB® X IDE or mass storage
programming while the external tool is active.
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4. Hardware Description

4.1 Connectors

4.1.1 PIC18F47Q10 Curiosity Nano Pinout
All the PIC18F47Q10 I/O pins are accessible at the edge connectors on the board. The image below shows the
board pinout.

Figure 4-1. PIC18F47Q10 Curiosity Nano Pinout
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Info:  Peripheral signals shown in the image above, such as UART, I2C, SPI, ADC, PWM, and others, are
shown at specific pins to comply with the Curiosity Nano Board standard. These signals can usually be
routed to alternate pins using the Peripheral Pin Select (PPS) feature in the PIC18F47Q10.

4.1.2 Using Pin-Headers
The edge connector footprint on PIC18F47Q10 Curiosity Nano has a staggered design where each hole is shifted 8
mil (~0.2 mm) off-center. The hole shift allows regular 100 mil pin-headers to be used without soldering on the board.
The pin-headers can be used in applications like pin sockets and prototyping boards without issues once they are
firmly in place.
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Figure 4-2. Attaching Pin-Headers to the Curiostiy Nano Board

Figure 4-3. Connecting to Curiosity Nano Base for Click boards™

Tip: Start at one end of the pin header and gradually insert the header along the length of the board.
Once all the pins are in place, use a flat surface to push them in.

Tip: For applications where the pin-headers will be used permanently, it is still recommended to solder
them in place.

Important: Once the pin-headers are in place, they are hard to remove by hand. Use a set of pliers and
carefully remove the pin-headers to avoid damage to the pin-headers and PCB.

4.2 Peripherals
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4.2.1 LED
One yellow user LED is available on the PIC18F47Q10 Curiosity Nano board. It can be controlled by either GPIO or
PWM. Driving the connected I/O line to GND can also activate the LED.

Table 4-1. LED Connection

PIC18F47Q10 Pin Function Shared Functionality

RE0 Yellow LED0 Edge connector

4.2.2 Mechanical Switch
The PIC18F47Q10 Curiosity Nano board has one mechanical switch - a generic user-configurable switch. Pressing it
will connect the I/O pin to ground (GND).

Tip: There is no externally connected pull-up resistor on the switch. The internal pull-up resistor on pin
RE2 must be enabled to use the switch.

Table 4-2. Mechanical Switch

PIC18F47Q10 Pin Description Shared Functionality

RE2 User switch (SW0) Edge connector, On-board debugger

4.2.3 Crystal
The PIC18F47Q10 Curiosity Nano board has a 32.768 kHz crystal footprint made for standard 3.2 mm by 1.5 mm
surface-mounted crystals with two terminals.

The crystal footprint is not connected to the PIC18F47Q10 by default, as the GPIOs route out to the edge connector.
Some hardware modifications are required to use the crystal.

• The two I/O lines routed to the edge connector must be disconnected to reduce the chance of contention to the
crystal and to remove excessive capacitance on the lines

• Disconnect the edge connector by cutting the two cut-straps on the bottom side of the board, marked RC0 and
RC1

• Connect the crystal by soldering on a solder blob on each of the circular solder points next to the crystal on the
top side of the board, J210 and J211

Figure 4-4 show cut straps and solder points.

The PIC18F47Q10 Curiosity Nano board has been tested with a 7 pF equivalent load capacitance 70 kΩ ESR crystal
(VMK3-9001-32K7680000TR) and 5 pF load capacitors. A similar setup is recommended when using a 32.768 kHz
crystal with the PIC18F47Q10 Curiosity Nano.

The crystal has a cut-strap next (J209) to it, which can be used to measure the oscillator safety factor. This is done by
cutting the strap and adding a 0402 SMD resistor across the strap. More information about oscillator allowance and
safety factor can be found in the AN2648 application note from Microchip.

Table 4-3. Crystal Connections

PIC18F47Q10 Pin Function Shared Functionality

RC0 SOSCO (Crystal output) Edge connector

RC1 SOSCI (Crystal input) Edge connector

 PIC18F47Q10 Curiosity Nano
Hardware Description

© 2022 Microchip Technology Inc.
and its subsidiaries

 User Guide DS40002103C-page 25

https://www.microchip.com//wwwAppNotes/AppNotes.aspx?appnote=en592059


Figure 4-4. Crystal Connection and Cut Straps
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4.2.4 On-Board Debugger Implementation
PIC18F47Q10 Curiosity Nano features an on-board debugger that can be used to program and debug the
PIC18F47Q10 using ICSP. The on-board debugger also includes a virtual serial port (CDC) interface over UART
and debug GPIO. MPLAB® X IDE can be used as a front-end for the on-board debugger for programming and
debugging. MPLAB Data Visualizer can be used as a front-end for the CDC and debug GPIO.

4.2.4.1 On-Board Debugger Connections
The table below shows the connections between the target and the debugger section. All the connections between
the target and the debugger are tri-stated when the debugger is not using the interface. Hence, there are few
contaminations of the signals, e.g., the pins can be configured to anything the user wants.

For further information on how to use the capabilities of the on-board debugger, see 3.1.  On-Board Debugger
Overview.

Table 4-4. On-Board Debugger Connections

PIC18F47Q10
Pin

Debugger Pin Function Shared Functionality

RD1 CDC TX UART RX (PIC18F47Q10 RX line) Edge connector

RD0 CDC RX UART TX (PIC18F47Q10 TX line) Edge connector

RB7 DBG0 ICSPDAT Edge connector

RB6 DBG1 ICSPCLK Edge connector

RE2 DBG2 SW0/GPIO Edge connector

RE3 DBG3 MCLR Edge connector

 PIC18F47Q10 Curiosity Nano
Hardware Description

© 2022 Microchip Technology Inc.
and its subsidiaries

 User Guide DS40002103C-page 26

https://www.microchip.com/en-us/development-tools-tools-and-software/embedded-software-center/mplab-data-visualizer


5. Hardware Revision History and Known Issues
This user guide provides information about the latest available revision of the board. The following sections contain
information about known issues, a revision history of older revisions, and how older revisions differ from the latest
revision.

5.1 Identifying Product ID and Revision
There are two ways to find the revision and product identifier of the PIC18F47Q10 Curiosity Nano: Either by utilizing
the MPLAB® X IDE Kit Window or by looking at the sticker on the bottom of the PCB.

The Kit Window will pop up when connecting PIC18F47Q10 Curiosity Nano to a computer with MPLAB® X IDE
running. The first six digits of the serial number, listed under kit information, contain the product identifier and
revision.

Tip:  If closed, the Kit Window can be opened in MPLAB® X IDE through the menu bar Window > Kit
Window.

The same information is found on the sticker on the bottom side of the PCB. Most boards will have the identifier and
revision printed in plain text as A09-nnnn\rr, where “nnnn” is the identifier, and “rr” is the revision.

The serial number string has the following format:

"nnnnrrssssssssss"

n = product identifier

r = revision

s = serial number

The product identifier for PIC18F47Q10 Curiosity Nano is A09-3246.

5.2 Revision 6
Revision 6 is built with PIC18F47Q10 revision B2 or later.

5.3 Revision 5
Revision 5 is built with PIC18F47Q10 revision A4.

The CVD feature may not function properly on some of the pins. Contact your local Microchip Field Applications
Engineer, distributor, or sales representative for a replacement board to minimize the impact on your product
development activities.

5.4 Revision 2
Revision 2 is the initially released revision and built with PIC18F47Q10 revision A4.

The CVD feature may not function properly on some of the pins. Contact your local Microchip Field Applications
Engineer, distributor, or sales representative for a replacement board to minimize the impact on your product
development activities.

The crystal footprint is connected by default, and RC0 and RC1 are disconnected from the edge connector by default.

Revision 2 does not have the Target Power strap, as described in 3.4.  Low-Power Measurement.
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The holes along the edge connections are not staggered, as described in 4.1.2.  Using Pin-Headers. Soldering is
required to mount pin headers.

Known issue: Power supply output is limited to 2.3-5.5V.
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6. Document Revision History
Doc. rev. Date Comment

C 09/2022 Revision 6 is added to the hardware revision history

B 10/2020 Document updated with the latest information. Images updated to revision 5. The
crystal chapter is rewritten to reflect changes in revision 5.

A 03/2019 Initial document release
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7. Appendix
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Figure 7-1. PIC18F47Q10 Curiosity Nano MCU Schematicrotatethispage90
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Figure 7-2. PIC18F47Q10 Curiosity Nano Debugger Schematicrotatethispage90
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Vin: 2.5V to 5.5V
Vout: Fixed 3.3V
Imax: 500mA
Dropout: 260mV @ 500mA

MIC5353:
Vin: 2.6V to 6V
Vout: 1.25V to 5.1V
Imax: 500mA
Dropout (typical): 50mV@150mA, 160mV @ 500mA
Accuracy: 2% initial
Thermal shutdown and current limit

Maximum output voltage is limited by the input voltage and the dropout voltage in the regulator.
(Vmax = Vin - dropout)

J100:
- Cut-strap used for full separation of target power from the level shifters and on-board regulators.
- For current measurements using an external power supply, this strap could be cut for more
accurate measurements. Leakage back through the switch is in the micro ampere range.
J101:
- For current measurements using the on-board power supply, this strap must be cut and an
ammeter connected across.

Adjustable output and limitations:
- The onboard debugger can adjust the output voltage of the regulator between 1.25V and 5.1V to the target.
- The level shifters have a minimal voltage level of 1.65V and will limit the minimum operating voltage allowed for the
target to still allow communication.
- The output switch has a minimal voltage level of 1.70V and will limit the minimum voltage delivered to the target.
- Firmware configuration will limit the voltage range to be within the the target specification.
- Firmware feedback loop will adjust the output voltage accuracy to within 0.5%.

PTC Resettable fuse:
Hold current: 500mA
Trip current: 1000mA

R113:
Pull down to prevent
DBG3_CTRL from
floating when debugger is
not powered.
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7.2 Assembly Drawing
Figure 7-3. PIC18F47Q10 Curiosity Nano Assembly Drawing Top

PIC®
MCU

b
Figure 7-4. PIC18F47Q10 Curiosity Nano Assembly Drawing Bottom

c
tR
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7.3 Curiosity Nano Base for Click boards™

Figure 7-5. PIC18F47Q10 Curiosity Nano Pinout Mapping
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7.4 Disconnecting the On-Board Debugger
The on-board debugger and level shifters can be completely disconnected from the PIC18F47Q10.

The block diagram below shows all connections between the debugger and the PIC18F47Q10. The rounded boxes
represent connections to the board edge. The signal names shown are also printed in silkscreen on the bottom side
of the board.

To disconnect the debugger, cut the straps shown in Figure 7-7.

Attention: Cutting the GPIO straps to the on-board debugger will disable the virtual serial port,
programming, debugging, and data streaming. Cutting the power supply strap will disconnect the on-board
power supply.

Tip: Reconnect any cut connection by using solder. Alternatively, mount a 0Ω 0402 resistor.

Tip: When the debugger is disconnected, an external debugger can be connected to holes, as shown
in Figure 7-7. Details about connecting an external debugger are described in 3.6.  Connecting External
Debuggers.

Figure 7-6. On-Board Debugger Connections Block Diagram
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Figure 7-7. On-Board Debugger Connection Cut Straps

GPIO straps (bottom side) Power Supply strap (top side)
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Microchip Information

The Microchip Website
Microchip provides online support via our website at www.microchip.com/. This website is used to make files and
information easily available to customers. Some of the content available includes:

• Product Support – Data sheets and errata, application notes and sample programs, design resources, user’s
guides and hardware support documents, latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical support requests, online
discussion groups, Microchip design partner program member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip press releases, listing of
seminars and events, listings of Microchip sales offices, distributors and factory representatives

Product Change Notification Service
Microchip’s product change notification service helps keep customers current on Microchip products. Subscribers will
receive email notification whenever there are changes, updates, revisions or errata related to a specified product
family or development tool of interest.

To register, go to www.microchip.com/pcn and follow the registration instructions.

Customer Support
Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Embedded Solutions Engineer (ESE)
• Technical Support

Customers should contact their distributor, representative or ESE for support. Local sales offices are also available to
help customers. A listing of sales offices and locations is included in this document.

Technical support is available through the website at: www.microchip.com/support

Microchip Devices Code Protection Feature
Note the following details of the code protection feature on Microchip products:

• Microchip products meet the specifications contained in their particular Microchip Data Sheet.
• Microchip believes that its family of products is secure when used in the intended manner, within operating

specifications, and under normal conditions.
• Microchip values and aggressively protects its intellectual property rights. Attempts to breach the code

protection features of Microchip product is strictly prohibited and may violate the Digital Millennium Copyright
Act.

• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of its code. Code
protection does not mean that we are guaranteeing the product is “unbreakable”. Code protection is constantly
evolving. Microchip is committed to continuously improving the code protection features of our products.

Legal Notice
This publication and the information herein may be used only with Microchip products, including to design, test,
and integrate Microchip products with your application. Use of this information in any other manner violates these
terms. Information regarding device applications is provided only for your convenience and may be superseded
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by updates. It is your responsibility to ensure that your application meets with your specifications. Contact your
local Microchip sales office for additional support or, obtain additional support at www.microchip.com/en-us/support/
design-help/client-support-services.

THIS INFORMATION IS PROVIDED BY MICROCHIP "AS IS". MICROCHIP MAKES NO REPRESENTATIONS
OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY
OR OTHERWISE, RELATED TO THE INFORMATION INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, AND FITNESS FOR A PARTICULAR PURPOSE,
OR WARRANTIES RELATED TO ITS CONDITION, QUALITY, OR PERFORMANCE.

IN NO EVENT WILL MICROCHIP BE LIABLE FOR ANY INDIRECT, SPECIAL, PUNITIVE, INCIDENTAL, OR
CONSEQUENTIAL LOSS, DAMAGE, COST, OR EXPENSE OF ANY KIND WHATSOEVER RELATED TO THE
INFORMATION OR ITS USE, HOWEVER CAUSED, EVEN IF MICROCHIP HAS BEEN ADVISED OF THE
POSSIBILITY OR THE DAMAGES ARE FORESEEABLE. TO THE FULLEST EXTENT ALLOWED BY LAW,
MICROCHIP'S TOTAL LIABILITY ON ALL CLAIMS IN ANY WAY RELATED TO THE INFORMATION OR ITS USE
WILL NOT EXCEED THE AMOUNT OF FEES, IF ANY, THAT YOU HAVE PAID DIRECTLY TO MICROCHIP FOR
THE INFORMATION.

Use of Microchip devices in life support and/or safety applications is entirely at the buyer's risk, and the buyer agrees
to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting
from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual property rights
unless otherwise stated.

Trademarks

The Microchip name and logo, the Microchip logo, Adaptec, AVR, AVR logo, AVR Freaks, BesTime, BitCloud,
CryptoMemory, CryptoRF, dsPIC, flexPWR, HELDO, IGLOO, JukeBlox, KeeLoq, Kleer, LANCheck, LinkMD,
maXStylus, maXTouch, MediaLB, megaAVR, Microsemi, Microsemi logo, MOST, MOST logo, MPLAB, OptoLyzer,
PIC, picoPower, PICSTART, PIC32 logo, PolarFire, Prochip Designer, QTouch, SAM-BA, SenGenuity, SpyNIC, SST,
SST Logo, SuperFlash, Symmetricom, SyncServer, Tachyon, TimeSource, tinyAVR, UNI/O, Vectron, and XMEGA are
registered trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

AgileSwitch, APT, ClockWorks, The Embedded Control Solutions Company, EtherSynch, Flashtec, Hyper Speed
Control, HyperLight Load, Libero, motorBench, mTouch, Powermite 3, Precision Edge, ProASIC, ProASIC Plus,
ProASIC Plus logo, Quiet- Wire, SmartFusion, SyncWorld, Temux, TimeCesium, TimeHub, TimePictra, TimeProvider,
TrueTime, and ZL are registered trademarks of Microchip Technology Incorporated in the U.S.A.

Adjacent Key Suppression, AKS, Analog-for-the-Digital Age, Any Capacitor, AnyIn, AnyOut, Augmented Switching,
BlueSky, BodyCom, Clockstudio, CodeGuard, CryptoAuthentication, CryptoAutomotive, CryptoCompanion,
CryptoController, dsPICDEM, dsPICDEM.net, Dynamic Average Matching, DAM, ECAN, Espresso T1S,
EtherGREEN, GridTime, IdealBridge, In-Circuit Serial Programming, ICSP, INICnet, Intelligent Paralleling, IntelliMOS,
Inter-Chip Connectivity, JitterBlocker, Knob-on-Display, KoD, maxCrypto, maxView, memBrain, Mindi, MiWi, MPASM,
MPF, MPLAB Certified logo, MPLIB, MPLINK, MultiTRAK, NetDetach, Omniscient Code Generation, PICDEM,
PICDEM.net, PICkit, PICtail, PowerSmart, PureSilicon, QMatrix, REAL ICE, Ripple Blocker, RTAX, RTG4, SAM-
ICE, Serial Quad I/O, simpleMAP, SimpliPHY, SmartBuffer, SmartHLS, SMART-I.S., storClad, SQI, SuperSwitcher,
SuperSwitcher II, Switchtec, SynchroPHY, Total Endurance, Trusted Time, TSHARC, USBCheck, VariSense,
VectorBlox, VeriPHY, ViewSpan, WiperLock, XpressConnect, and ZENA are trademarks of Microchip Technology
Incorporated in the U.S.A. and other countries.

SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

The Adaptec logo, Frequency on Demand, Silicon Storage Technology, and Symmcom are registered trademarks of
Microchip Technology Inc. in other countries.

GestIC is a registered trademark of Microchip Technology Germany II GmbH & Co. KG, a subsidiary of Microchip
Technology Inc., in other countries.

All other trademarks mentioned herein are property of their respective companies.
© 2022, Microchip Technology Incorporated and its subsidiaries. All Rights Reserved.

ISBN: 978-1-6683-1163-9
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Quality Management System
For information regarding Microchip’s Quality Management Systems, please visit www.microchip.com/quality.
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